Disclaimer:

This manual is licensed under the axiUm software and maintenance agreement. You may not use this manual except in compliance with the license. The information contained in these materials is proprietary and confidential to Exan and/or its subsidiaries or affiliates and is provided for the sole use of the individual or entity to whom it is addressed. These materials must be kept in the strictest confidence.

The contents of these materials are protected by federal and international intellectual property laws. The Exan logo is a registered trademark and is the sole and exclusive property of Exan.

These materials may contain third-party copyright and/or trademark materials, the use of which has not always been specifically authorized by the intellectual property owner. All copyrights and/or trademarks contained in these materials are the sole and exclusive property of their respective owners.

Information in this document is subject to change without notice. No portion of these materials may be reprinted, republished, modified, reproduced, sold, disseminated, disclosed or distributed in any form to any other party without the express written consent of Exan.

All names used in axiUm (whether online, in print, or any other media) are fictitious and are used herein for the purposes of example and demonstration on how to use axiUm. Any similarity to real people is a coincidence.

Copyright © 2011 Exan. All rights reserved.

Botan (http://botan.randombit.net/) is distributed under these terms:


Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution.

This software is provided by the author(s) “as is” and any express or implied warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, are disclaimed. In no event shall the author(s) or contributor(s) be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.
# Table of Contents

**About this Guide** ........................................................................................................ iii

**Document Conventions** .......................................................................................... iii
**Document Icons** ....................................................................................................... iv

## Chapter 1: About Patient Care ........................................................................ 1
- Opening the Patient Care Module ................................................................. 1
- About the Patient Care Window ................................................................. 3

## Chapter 2: Patient Care Setup ........................................................................ 5
- Setting up Patient Care Views ................................................................. 5
  - Setting up Patient Care View Options ............................................. 5
  - Setting up User Access for Patient Care View Options ................. 7
  - Setting up Patient Care View Records ......................................... 11
  - Setting up Default User Access for Patient Care View Records .... 13
  - Setting up User Access for Patient Care View Records ............... 15
- Setting up Patient Care Tabs ................................................................. 20
  - Managing Custom Reports .............................................................. 20
    - Adding Custom Reports .......................................................... 20
    - Modifying Custom Reports ...................................................... 22
    - Deleting Custom Reports ......................................................... 24
  - Setting up User Access for Custom Reports .................................. 25
  - Setting up Patient Care Activity Options for the Current Workstation 30

## Chapter 3: Using Patient Care ........................................................................ 33
- Searching Patient Care Records ........................................................... 33
- Printing Patient Care List ................................................................. 35

## Chapter 4: Troubleshooting ........................................................................... 37
- Message Boxes .......................................................................................... 37
About this Guide

This axiUm User Guide will help you start using axiUm. It shows you how to:

• Follow document conventions.
• Familiarize yourself with the Patient Care module.
• Use axiUm features for day-to-day tasks.

The examples in the axiUm User Guide show system-required field entries and may not reflect field entries typical of your institution. Check with your institution for a list of fields required to be completed before saving the current window. axiUm will not let you save your entries until all system-required entries are completed. If you try saving a window with incomplete system-required fields, a message box displays. When you close the message box, the cursor will be placed on the first system-required field that you missed. Once all system-required fields are entered, you can save and close the window.

Also note that default displays, tabs in windows, and other screen elements shown in the axiUm User Guide may look different from your axiUm setup.

Document Conventions

This manual uses the following styles to identify the different interface elements:

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Names of interface elements such as buttons, check boxes, list boxes, list views, menu names, menu choices, options, tabs, and text boxes.</td>
</tr>
<tr>
<td><em>Italics</em></td>
<td>Indicates when a special term is used for the first time, and to emphasize key words or terms.</td>
</tr>
<tr>
<td>Monospace Fonts</td>
<td>Data entered by the user.</td>
</tr>
</tbody>
</table>
Document Icons

This guide also uses the following icons to identify the different document elements:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Pencil" /></td>
<td>Notes and helpful information. For example, things that will become apparent later on in the procedure.</td>
</tr>
<tr>
<td><img src="image2" alt="Exclamation" /></td>
<td>Important information or steps you must take. For example, if you do not complete this step you may be unable to complete a task later on.</td>
</tr>
<tr>
<td><img src="image3" alt="Lightbulb" /></td>
<td>Tips, ideas, and alternative methods. For example, using shortcuts, applying previously learned tools, or suggesting different uses.</td>
</tr>
<tr>
<td><img src="image4" alt="Warning" /></td>
<td>Warnings before taking action. For example, precautions against irreversible actions, or actions that require a lot of work to undo.</td>
</tr>
<tr>
<td><img src="image5" alt="Apple" /></td>
<td>Challenges and extra steps. For example, steps that take you beyond the basic procedures.</td>
</tr>
</tbody>
</table>
Staff and students can use the Patient Care module to:

- View all records in axiUm pertaining to a patient.
- Print lists of patient records.

This chapter covers the following topics:

- Opening the Patient Care module
- About the Patient Care window

Read the following sections to familiarize yourself with the features of the Patient Care module.

1 Opening the Patient Care Module

There are different methods to access the Patient Care module:

- Icon
- Actions menu
- Desktop

The following instructions describe these methods.

▼To open the Patient Care module using the icon:

Click (Patient Care).
To open the Patient Care module using the Actions menu:

From the **Actions** menu, click **Patient Care**.

![Actions menu]

To open the Patient Care module using the Desktop:

From the Desktop, click **Patient Care**.

The next section describes the Patient Care module window.
2 About the Patient Care Window

This is how the Patient Care window may look when you open it for the first time:

You are now ready to begin using the Patient Care window.
This chapter covers the setup tasks you must complete before using the Patient Care module. You must have access rights (i.e., administrator access level) to access these windows.

This chapter covers the following topics:

- Setting up Patient Care views
- Setting up Patient Care tabs

At the end of this chapter you will be familiar with these tasks.

1 Setting up Patient Care Views

This section covers the following tasks:

- Setting up Patient Care view options
- Setting up user access for Patient Care view options
- Setting up Patient Care view records
- Setting up default user access for Patient Care view records
- Setting up user access for Patient Care view records

1.1 Setting up Patient Care View Options

Patient Care view options are the options displayed in the Patient Care window’s View drop-down field. It is a name to represent a group of Patient care view records.
To set up Patient Care view options:

1. Go to Maintenance module's Patient tab.
2. Double-click the Patient Care Views icon.

    axiUm displays the Patient Care Views window. For information on the Patient Care Views window, refer to the axiUm Reference Manual for Maintenance and see Patient Care Views Window on page 578.

3. Click (Clear Data).

    axiUm clears the field.

4. In the Description field, enter the name of the Patient Care view option you want to create. For example, we will enter Administrative.

5. Click (Add a new Record).

    axiUm adds the new record to the list view, in alphabetical order.

6. Click (Close).

    axiUm closes the Patient Care Views window.
You have now successfully created a Patient Care view option. The options you create here can be displayed in the Patient Care window’s View drop-down field.

Next, you must grant user level access to this Patient Care view option. For instructions on granting user level access to Patient Care view options, continue reading the next section, Setting up User Access for Patient Care View Options.

1.2 Setting up User Access for Patient Care View Options

Before you can grant user level access to Patient Care view options, you must create Patient Care view options. For instructions on creating Patient Care view options, see the previous instruction, Setting up Patient Care View Options on page 5.

You can set up user level access for Patient Care view options using one of the following methods:

- Patient Care View Access window
- Level Access window

This section describes both methods.

▼ To set up user level access for Patient Care view options using the Patient Care View Access window:

1. Go to Maintenance module’s Patient tab.
2. Double-click the Patient Care Views icon.

axiUm displays the Patient Care Views window. For information on the Patient Care Views window, refer to the axiUm Reference Manual for Maintenance and see Patient Care Views Window on page 578.

3. Select an item from the list view. For our example, we will select Administrative.
4. Click (Level Access).

axiUm displays the Patient Care View Access window. For information on the Patient Care View Access window, refer to the axiUm Reference Manual for Maintenance and see Patient Care View Access Window on page 583.

By default, all users levels are given no access to new patient care view options.

5. From the list view, select an item. For our example, we will select Dental Student.

6. From the Access drop-down field, select an access level. For our example, we will select Yes.

7. Click (Modify Record).

axiUm saves the changes.

8. Click (Close).

axiUm closes the Patient Care View Access window.
You have now successfully granted user level access for a Patient Care view option using the Patient Care View Access window. Users with this access level who are currently logged into axiUm will have access to this Patient Care view option the next time they log into axiUm.

For instructions on granting user level access for a Patient Care view option using the Level Access window, continue reading the next procedure.

▼To set up user level access for Patient Care view options using the Level Access window:

1. Go to Maintenance module’s System tab.
2. Double-click the Level Access icon.

axiUm displays the Level Access window. For information on the Level Access window, refer to the axiUm Reference Manual for Maintenance and see Level Access Window on page 830.

3. Expand the Patient Care Views item.
4. Highlight an item. For our example, we will highlight Administrative.
5. From the list view, select an item. For our example, we will select Dental Student.
6. From the Access drop-down list, select an access level. For our example, we will select Yes.
7. Click (Modify Record).

axiUm saves the changes.

8. Click (Close).

axiUm closes the Level Access window.

You have now successfully granted user level access for a Patient Care view option using the Level Access window.

Users with this access level who are currently logged into axiUm will have access to this Patient Care view option the next time they log into axiUm.

axiUm displays this Patient Care view option only if there are Patient Care view records within it, and the user is given access to these Patient Care view records. For instructions on setting up user access to Patient Care view records, see Setting up User Access for Patient Care View Records on page 15.
1.3 Setting up Patient Care View Records

The Patient Care view records you set up here are the default record types that axiUm displays in the selected Patient Care view option for all workstations. For instructions on setting up Patient Care view options, see Setting up Patient Care View Options on page 5.

To set up Patient Care View records:

1. Go to Maintenance module’s Patient tab.
2. Double-click the Patient Care Views icon.

axiUm displays the Patient Care Views window. For information on the Patient Care Views window, refer to the axiUm Reference Manual for Maintenance and see Patient Care Views Window on page 578.

3. From the list view, highlight an item. For our example, we will highlight Administrative.
4. Click i (Patient Care View Records).

axiUm displays the Patient Care View Records window. For information on the Patient Care View Records window, refer to the axiUm Reference Manual for Maintenance and see Patient Care View Records Window on page 580.
5. Click \(\text{Clear Data}\).

axiUm clears the field.

6. From the Record drop-down field, select an item. For our example, we will select Patient Referral.

7. Click \(\text{Add a new Record}\).

axiUm adds the new record to the list view.

8. Click \(\text{Close}\).

axiUm closes the Patient Care View Records window.

You have now successfully created a Patient Care view record in a Patient Care view option. The options you create here can be displayed in the Patient Care window’s list view when you select the associated Patient Care view option from the View drop-down field.

Next, you must grant user level access to this Patient Care view record. For instructions on granting user level access to Patient Care view records, see Setting up User Access for Patient Care View Records on page 15.
1.4 Setting up Default User Access for Patient Care View Records

Setting up default user level access for Patient Care view records allows you to re-apply the same user level access to other Patient Care view records that you add to different Patient Care view options.

Changing the user level access of a view record within a particular view option (e.g. an Insurance Policy view record used in the Financial view option) does not change user level access of the same record already used in a different view option (e.g. the same Insurance Policy view record but used in the Insurance view option). Changes made to the default user access rights are transposed only to subsequently selected view records.

To set up default user access for Patient Care view records:

1. Go to Maintenance module’s Patient tab.
2. Double-click the Patient Care Views icon.

axiUm displays the Patient Care Views window. For information on the Patient Care Views window, refer to the axiUm Reference Manual for Maintenance and see Patient Care Views Window on page 578.

3. From the list view, select All Records.
4. Click (Patient Care View Records).
axiUm displays the Patient Care View Records window. For information on the Patient Care View Records window, refer to the axiUm Reference Manual for Maintenance and see Patient Care View Records Window on page 580.

5. From the list view, highlight the first item. For our example, we will highlight Patient Record.

6. Click (Level Access).

axiUm displays the Patient Care Record Access window. For information on the Patient Care Record Access window, refer to the axiUm Reference Manual for Maintenance and see Patient Care Record Access Window on page 581.

7. From the list view, select the first item. For our example, we will select Administrator.

8. From the Access drop-down field, select an access level. For our example, we will select Yes.

9. Click (Modify Record).
axiUm saves the changes.

10. Click (Close).

axiUm closes the Patient Care View Records window.

The next time you add this patient care view record to a patient care view option, axiUm uses this new default user access.

1.5 Setting up User Access for Patient Care View Records

Before you can grant user level access to Patient Care view records, you must create Patient Care view records. For instructions on creating Patient Care view records, see the previous instruction, Setting up Patient Care View Records on page 11.

You can set up user level access for Patient Care view options using one of the following methods:

- Patient Care View Access window
- Level Access window

This section describes both methods.

▼To set up user level access for Patient Care view options using the Patient Care View Access window:

1. Go to Maintenance module's Patient tab.
2. Double-click the Patient Care Views icon.
axiUm displays the Patient Care Views window. For information on the Patient Care Views window, refer to the axiUm Reference Manual for Maintenance and see *Patient Care Views Window* on page 578.

3. Select an item from the list view. For our example, we will select *Administrative*.

4. Click ![Patient Care View Records](image).

   axiUm displays the Patient Care View Records window. For information on the Patient Care View Records window, refer to the axiUm Reference Manual for Maintenance and see *Patient Care View Records Window* on page 580.

5. Highlight an item from the list. For our example, we will highlight *Patient Referral*.

6. Click ![Level Access](image).

   axiUm displays the Patient Care Record Access window using the default user level access. For instructions on setting up default user level access for Patient Care view
records, see *Setting up Default User Access for Patient Care View Records* on page 13.

7. From the list view, select an item. For our example, we will select **Dental Student**.

8. From the **Access** drop-down field, select an access level. For our example, we will select **Yes**.

9. Click (Modify Record).

axiUm saves the changes.

10. Click (Close).

axiUm closes the Patient Care View Records window.
You have now successfully granted user level access for a Patient Care view record using the Patient Care View Access window. Users with this access level who are currently logged into axiUm will have access to this Patient Care view record the next time they log into axiUm.

For instructions on granting user level access for a Patient Care view record using the Level Access window, continue reading the next procedure.

▼To set up user level access for Patient Care view options using the Level Access window:

1. Go to Maintenance module's System tab.
2. Double-click the Level Access icon.

axiUm displays the Level Access window. For information on the Level Access window, refer to the axiUm Reference Manual for Maintenance and see Level Access Window on page 830.

3. Expand the Patient Care Views item.
4. Expand an item below the Patient Care Views item. For our example, we will expand the item Administrative.
5. Highlight an item from the list. For our example, we will expand the item Patient Referral.

axiUm uses the default access level. For instructions on setting default user access for Patient Care view records, see Setting up Default User Access for Patient Care View Records on page 13.
6. From the list view, select an item. For our example, we will select Dental Student.

7. From the Access drop-down list, select an access level. For our example, we will select Yes.

8. Click (Modify Record).

axiUm saves the changes.

9. Click (Close).

axiUm closes the Level Access window.

You have now successfully granted user level access for a Patient Care view record using the Level Access window. Users with this access level who are currently logged into axiUm will have access to this Patient Care view record the next time they log into axiUm.
2 Setting up Patient Care Tabs

This section covers the following tasks:

- Managing custom reports
- Setting up user access for custom reports
- Setting up Patient Care activity options for the current workstation

2.1 Managing Custom Reports

Adding Custom Reports

You can add up to 30 customized Crystal Reports to display in the Patient Care window. Each Crystal Report you add is displayed in a separate tab in the Patient Care window.

▼To add custom reports:

1. Go to Maintenance module's System tab.
2. Double-click the Custom Reports icon.

axiUm displays the Custom Reports window. For information on the Custom Reports window, refer to the axiUm Reference Manual for Maintenance and see Custom Reports Window on page 821.

3. Click (Clear Data).
axiUm clears the fields.

4. From the **Type** drop-down field, select **Patient Care**.

5. In the **Description** field, enter the text you want axiUm to display in the tab in the Patient Care window. For our example, we will enter **Referrals**.

6. In the **File** field, select the file path and name of the custom report by clicking (ellipsis) and browsing to the file’s location. For our example, we will select the Crystal Report called **ReferralReport.rpt**.

7. Click (Add a new Record).

axiUm adds the new record to the list view.

8. Click (Close).

axiUm closes the Custom Reports window.

You have now successfully added a Crystal Report file. The Crystal Report file you add here can be displayed in its own tab in the Patient Care window.
Next, you must grant user level access to this Crystal Report file. For instructions on granting user level access to Crystal Report files, see *Setting up User Access for Custom Reports* on page 25.

**Modifying Custom Reports**

For our example, we will change the text displayed on the tab of the Patient Care window from Referrals to Pt Transfer, and also change the order of tab displays.

▼To modifying custom reports:

1. Go to **Maintenance** module's **System** tab.
2. Double-click the **Custom Reports** icon.

    axiUm displays the Custom Reports window. For information on the Custom Reports window, refer to the axiUm Reference Manual for Maintenance and see *Custom Reports Window* on page 821.

3. From the **Type** drop-down field, select **Patient Care**.
4. From the list view, highlight an item. For our example, we will highlight **Referrals**.

    We will change the name of the text displayed in the tab in the Patient Care window.

5. In the **Description** field, enter a new name. For our example, we will enter **Pt Transfer**.

6. Click (Modify Record).
axiUm saves the changes.

Next, we will change the order of the tab displayed in the Patient Care window.

7. Click **Up**.

axiUm moves the item up the list.

8. Click **(Modify Record)**.

axiUm saves the changes.

9. Click **(Close)**.

axiUm closes the Custom Reports window.

You have now successfully modified the display options of a Crystal Report file.
Deleting Custom Reports

▼To add custom reports:

1. Go to Maintenance module's System tab.
2. Double-click the Custom Reports icon.

axiUm displays the Custom Reports window. For information on the Custom Reports window, refer to the axiUm Reference Manual for Maintenance and see Custom Reports Window on page 821.

3. From the Type drop-down field, select Patient Care.
4. From the list view, highlight an item. For our example, we will highlight Pt Transfer.
5. Click Delete Record.
axiUm deletes the item from the list view.

6. Click ✗ (Close).

axiUm closes the Custom Reports window.

You have now successfully deleted a Crystal Report file within a custom report category. The next time you open the Patient Care module, axiUm deletes the tab from the Patient Care window.

2.2 Setting up User Access for Custom Reports

Before you can grant user level access to custom reports, you must add custom reports. For instructions on adding custom reports, see Adding Custom Reports on page 20.

You can set up user level access for custom reports using one of the following methods:

- Custom Reports window
- Level Access window

This section describes both methods.
To set up user level access for custom reports using the Custom Reports window:

1. Go to **Maintenance** module's **System** tab.
2. Double-click the **Custom Reports** icon.

axiUmm displays the Custom Reports window. For information on the Custom Reports window, refer to the axiUmm Reference Manual for Maintenance and see *Custom Reports Window* on page 821.

3. From the **Type** drop-down field, select **Patient Care**.
4. Select an item from the list view. For our example, we will select **Referrals**.
5. Click **Level Access**. 

6. From the list view, select an item. For our example, we will select Dental Student.

7. From the Access drop-down field, select an access level. For our example, we will select Yes.

8. Click (Modify Record).

axiUm saves the changes.

9. Click (Close).

axiUm closes the Report Access window.
You have now successfully granted user level access for a custom report using the Patient Care View Access window. Users with this access level who are currently logged into axiUm will have access to this Patient Care view record the next time they log into axiUm.

For instructions on granting user level access for a custom report using the Level Access window, continue reading the next procedure.

**To set up user level access for custom reports using the Level Access window:**

1. Go to Maintenance module’s System tab.
2. Double-click the Level Access icon.

axiUm displays the Level Access window. For information on the Level Access window, refer to the axiUm Reference Manual for Maintenance and see Level Access Window on page 830.

3. Expand the Custom Reports item.
4. Expand the Patient Care item.
5. Highlight an item from the list. For our example, highlight Referrals.
6. From the list view, select an item. For our example, we will select Dental Student.
7. From the Access drop-down list, select an access level. For our example, we will select Yes.
8. Click (Modify Record).
axiUm saves the changes.

9. Click (Close).

axiUm closes the Level Access window.

You have now successfully granted user level access for a custom report using the Level Access window. Users with this access level who are currently logged into axiUm will have access to this custom report the next time they log into axiUm.
2.3 Setting up Patient Care Activity Options for the Current Workstation

Default view options have now been set up for all workstations. For instructions on setting up default view options for all workstations, see Setting up Patient Care View Records on page 11.

Once these default view options are set up, you can change them for this workstation only, and for the current session only.

▲To set up Patient Care activity option for the current workstation, for the current session:

1. Open the Patient Care window.

   For instructions on opening the Patient Care window, see Opening the Patient Care Module on page 1.

2. From the View drop-down field, select an option. For our example, we will select Clinical.

3. Click (Options/Settings).

axiUm displays the Patient Care Activity Options window displaying the default options. For information on the Patient Care Activity Options window, refer to the axiUm Reference Manual for Patient Care and see Patient Care Activity Options Window on page 3.
4. Select and deselect different items. For our example, we will deselect the following items:

- Clinical Note
- Prescription
- Medical Alert

5. Click OK.

axiUm saves your selection and closes the Patient Care Activity Options window. If you currently have a patient selected in the Patient Care window, or if you run a search process, axiUm also updates the Patient Care window’s list view to match your
selection. For instructions on running a search, see *Searching Patient Care Records* on page 33.

You have successfully set up the Patient Care activity option for the current workstation, for the current session.

The next time you open the Patient Care Activity Options window, axiUm restores the default record display options.
This chapter covers the tasks you can accomplish using the Patient Care module.

This chapter covers the following topics:

- Searching Patient Care records
- Printing lists

At the end of this chapter you will be familiar with these tasks.

1 Searching Patient Care Records

▼To search for a Patient Care record:

1. Select a patient record.

For instructions on selecting a patient record, refer to the axiUm User Guide for Rolodex & Patient Card and see Viewing Patient Records on the Rolodex Module on page 15.
2. In the Patient Care window, select the Activity tab.

3. From the View drop-down field, select an option. For our example, we will select All Records.

4. In the Date From field, enter a date. For our example, we will enter 22/05/2011.

5. In the Date To field, enter a date. For our example, we will enter 22/07/2011.

6. Click (Search).

axiUm displays all items that match the search criteria.

You have now successfully found patient activity records in axiUm.
2 Printing Patient Care List

\(\text{To print a list of patient care records:}\)

1. Search for patient care records.

   For instructions on searching patient care records, see *Searching Patient Care Records* on page 33.

2. Right-click anywhere in the list view to display the **Print List** option.

3. Click **Print List**.

   axiUm displays the Select Printer window.

4. Highlight an item. This is the printer you want to print to.

   You can print to file by selecting the Print to File checkbox. When you click **OK**, axiUm prompts you to browse to a directory to save the file.

5. Click **Select**.
axiUm prints all the items on the list to the selected printer, similar to how they appear on the Patient Care window’s list view.

You have now successfully printed a list of items.

You can print any custom reports displayed in custom tabs. For information on printing these reports, refer to your Crystal Reports help file.
This chapter covers some of the problems you may come across while using the Patient Care module, their possible causes, and solutions.

1 Message Boxes

**Problem:**

You added a custom report to display in the Patient Care window, and axiUm correctly displays the associated tab in the Patient Care window. However, when you click on the tab, it displays the following message box:

*Image of message box showing an error.*

**Cause:**

The custom report you uploaded into axiUm is not a Crystal Report (e.g. *.PDF, *.doc, or *.txt). axiUm allows you to upload any report, however, only Crystal Reports can be displayed in the Patient Care module.

**Solution:**

Convert the custom report into a Crystal Report format.